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8 Quick Reports

Introduction
One of the most important tasks in data management is report genera-
tion. The Quick Report editor is one of two tools made available by 
4th Dimension for the purpose of designing reports. You use the Quick 
Report editor to create ad-hoc reports in the User environment. The 
other tool is the Form editor, which you can use to design reports in 
the Design environment. You should use an output form to design 
reports that require complex designs or programmatic processing.

Using the Quick Report editor, you can:

■ Produce lists of records.

■ Create break areas.

■ Produce cross-table reports.

■ Compute summary calculations.

■ Modify fonts and styles in the report.

■ Define borders and background colors on a cell basis.

■ Save and open quick report designs to disk.

■ Select different output types such as HTML or text file, 4D View or 4D 
Chart area, print or save to disk.

The Quick Report editor produces reports from the current selection of 
records. Before generating a report, set the current selection of records 
that you want to include in your report.
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Overview of the editor

In the user environment, the Quick Report editor appears as follows:

It consists of two main areas:

■ The Quick Report data area that is used to specify the type of report to 
be built and the data to be integrated; it also can be used to access the 
Quick Report Wizard:
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■ The actual Quick Report area:

This shows the area as it appears when a Quick Report area is inserted 
in a form. This is where actual column and row contents are created, 
where sort orders are defined, etc. Also, this area includes various 
toolbars, its own menu bar and contextual menus.

For example, this area could be placed in a form as depicted below:
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List Mode and 
Cross-table Mode

In the Quick Report editor there are two operation modes available 
which generate two specific types of reports: List and Cross table.

■ List mode
This is the default mode and was the only mode available in the 
previous version of the Quick Report editor. In this mode, reports 
would typically display records as a list with break levels where sums 
would be performed.The following is a typical List quick report. 

■ Cross-table mode
This mode allows you to display your report as a two-dimensional 
table. This is useful when you want to display data from a data source 
broken down into categories that actually are a function of two other 
data sources. 
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For example, a cross-table form would let you display in a table how 
many of each product type was sold in each quarter. The following is a 
typical Cross-table Quick Report.

Quick Report Basics
This section describes basic operations used when working with the 
Quick Report editor to design a report.

Creating a New 
Quick Report

By default, the Quick Report editor lets you create reports in the User 
environment. 
It is also possible to create reports from the Custom Menus mode, if a 
Quick Report area has been inserted into a form.

❿❿❿❿ To design a quick report:

1 Choose Quick... from the Report menu.
4th Dimension displays the Quick Report editor. If a previous report 
has been defined, it appears in the window. To erase the contents of 
the window, choose New from the File menu or click the icon New in 
the file management toolbar to begin a new Quick Report design.

2 Choose the type of report to be generated by clicking either on the 
List or Cross table button, located at the bottom left corner of the 
Quick Report editor:
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The List type is generally selected by default. The selection of a type 
modifies the Quick Report area. 

Loading and 
Saving a Quick 
Report Design

You can save a quick report design as a file that you can open from the 
Quick Report editor. The quick report design includes all of your speci-
fications for the report, but not the data. By saving report designs, you 
can maintain a library of quick report designs that you can use accord-
ing to your needs.

Note If you do not save your design, it is displayed the next time you open 
the Quick Report editor but only during the same work-session. 

Saving a Quick Report 
Design

❿❿❿❿ To save a quick report design:

1 Choose Save as from the File menu.
OR
Click the Save as icon in the file management toolbar .
4th Dimension displays a create-file dialog box in which you can name 
the quick report design.

Note Quick report files in 4th Dimension for Windows are denoted by the file 
extension .4QR.

2 Enter a filename for the quick report and click OK. 
4th Dimension saves the report as a file that you can open with the 
Quick Report editor. You can save the file on your hard disk. If you 
modify the parameters of the report subsequently and want to save 
them again, you just need to choose the Save command in the File 
menu. 

The new file will replace the previous one on the disk, without the 
standard save file dialog box appearing. 

Loading a Quick Report 
Design

When the Quick Report editor is open, you can load a saved design 
and use it to print a new report. You can use the same quick report 
design repeatedly to print different selections of records.

❿❿❿❿ To load a report design:

1 Choose Open from the File menu.
OR
Click the Open icon in the file management toolbar .
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4th Dimension displays an open-file dialog box displaying a list of 
available quick report designs. 

2 Double-click a filename or select a filename from the list and click OK.

4th Dimension replaces the current design with the design you opened.

The Quick Report Wizard
When creating a manual Quick report, you can use the Wizard to guide 
you through the creation of the report.

To invoke the wizard, click the Open wizard button in the Quick 
Report editor:

The pages of the wizard then replace the data area in the window of 
the Quick Report editor:

The construction of the report is then carried out through detailed 
steps with comments appearing in the right-hand part of the window. 

List of steps

Information
area
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To create a Quick Report using the wizard, follow the instructions 
displayed on the screen. 

To exit the wizard, click on the button to return to Manual mode:

Using the Quick Report Editor

Interface When you create a quick report, you can specify the following:

■ Columns that display fields or formulas, either from the current table 
or from related tables,

■ Sort levels and order (list mode),

■ Summary calculations,

■ Display format,

■ Text for labels,

■ Formats for numeric and Boolean data,

■ Font, font size, style, and justification for labels, summary calculations, 
and data,

■ Background colors on a cell column or row basis,

■ Borders,

■ Page headers and footers.
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List mode:

Cross-table mode:

Fields list

Sort list

Tool bars 
and menu bars

Report type
selection buttons

Master Table
drop-down list

Break row

Title and detail rows
Column divider

Field

Cell

selection list

Fields list
Sort orders

Tool bars 
and menu bars

Report type
selection buttons

Master Table
drop-down list

Title and detail rows

Column divider

Field

Cell

selection list
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The Quick Report editor contains the following elements: 

■ Master Table drop-down list: This menu is used to specify the master 
table that will be used as a basis for generating the report. The fields of 
this table are displayed in the Fields list and the related fields will be 
displayed in relation to this table. 

■ Fields list: This list lets you select the fields to be inserted into the 
report by double-clicking or by drag and drop. It displays either the list 
of fields found in the master table, the hierarchical list of tables and 
related fields or the hierarchical list of all the tables and fields of the 
database. You choose the type of display in the Field selection list 
located just above the area. 
Indexed fields appear in bold. You can also display and select the fields 
of related tables.

Note Only tables and fields which are not hidden appear in the Fields list of 
the Quick Report editor. For information about hiding tables and 
fields, refer to the 4th Dimension Design Reference manual.

■ All relations in automatic: This option is used to specify the way in 
which the Quick Report editor will make use of the relations between 
the different tables of the database. 
On principle, the editor can only use automatic relations. By default, 
the option is not checked and only automatic relations can be used by 
the editor. 
If the All relations in automatic option is checked, the Quick Report 
editor considers the manual relations of the database as automatic 
relations and will thus enable access to all the data related to the 
database. 

Note to developers The All relations in automatic option causes all the relations to pass 
into automatic for the current process, even after the Quick Report 
editor has been closed. If you want to make sure that all the relations 
will be manual after using the Quick Report editor, execute the 
statement AUTOMATIC RELATIONS(False;False). 

■ Column dividers: These lines indicate the boundaries between columns 
of the report. They can be moved manually in order to enlarge or 
reduce the size of each column. Manual resizing deselects the Auto-
matic Width option if it has been activated for the column concerned.

■ Cells: A cell is the intersection of a row and a column.
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■ Scroll bars: You use the scroll bars to view parts of the quick report 
design that extend beyond the area of the quick report form. 

■ Sort list/Sort order display area: 

■ In List mode, this list displays the fields of the report on which the 
sort will be carried out, as well as the sort order and whether it will 
be ascending or descending. Each field inserted into this list causes 
a sub-total row to be added in the Quick Report area. 

■ In Cross-table mode, this area displays the sort order for each data 
source.

■ Quick Report area: This area lets you build your report by inserting 
fields using drag and drop, double-clicking or via the contextual menu; 
you can also adjust the width of the columns added or delete breaks or 
formulas, define the colors and borders of cells, etc.

■ Title row: The title row is repeated for each page. This row displays 
the names of fields or formulas that have been inserted into the 
report. It is repeated for each page of the report. The Quick Report 
editor inserts field names by default, but you can modify the con-
tents.

■ Detail row: This row contains information drawn from each record 
and is repeated in the report for each record. You can associate a dis-
play format with it, depending on the type of data represented.

■ Subtotal rows: These rows display intermediate calculations as well 
as the wording that is associated with them. A row is created for 
each sort order.

Title row

Detail row

Column data source

Grand total row

Subtotal rows
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■ Column data sources: These titles indicate the source of the data for 
each column.

■ Data Sources: These two cells will house fields that will be used for 
the two categories of the array. The center cell can also accept fields 
sources and calculations at the same time.

■ Total cells: These cells are designed to house calculations on the col-
umn’s contents.

■ Title cells: These cells house the titles for the last column or the last 
row. Their contents can be modified.

The following figures shows completed quick report designs and the 
relationship between the specifications in the design and the printed 
output:

Data Sources

Last Column Title

Last row title

Total cells

List Report
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Contextual menus The Quick Report editor has contextual menus that make it easy to 
access certain row, column, and cell operations. Instead of making 
menu selections or working with the Cell or Column properties areas, 
you can perform certain operations by displaying a Quick Report 
contextual menu.

There are separate contextual menus for row, column, and cell 
operations.

❿❿❿❿ To use a contextual menu:

1 Position the pointer in a cell, a row title, or a column heading and hold 
down the right mouse button (on windows) or press the Control key 
while clicking in the report area (MacOS).
A contextual menu appears. The commands in the contextual menu 
depend on where your pointer is (i.e., a row label, column heading, or 
cell). Also, menu commands that are inappropriate for the particular 
row, column, or cell are disabled.

Cross-table 
mode
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2 Choose the desired menu command:

As with any contextual menu, this menu’s contents vary depending on 
which cell type is highlighted. Items available break down into five 
main types:

■ Font attributes,

■ Display formats,

■ Standard calculations,

■ Column or row management items, and

■ Cell borders.

Font Attributes These items appear in the contextual menu when a cell, column or row 
is selected. Selecting a font attribute will apply it to the current 
selection (cell, row or column). The Font attribute items appear as 
follows:

■ Font
Selecting this item displays the list of fonts installed on your machine 
from which you can select the font that will be applied to the items 
selected in the report area.

Once an item in the list is selected, a check mark is displayed next to it.

Cell

Row

Column
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■ Size
Selecting this item displays the list of font sizes from which you can 
select the font that will be applied to the items selected in the report 
area.

Once an item in the list is selected, a check mark is displayed next to it.

■ Style
Selecting this item displays the list styles (Plain, Bold, Italic, and 
Underline) from which you can select the font that will be applied to 
the items selected in the report area.

Once an item in the list is selected, a check mark is displayed next to it.

■ Justification
Selecting this item displays the list of justification attributes (Default, 
Left justified, Centered and Right justified).

Note Default is the default justification for this data type (left for numbers 
or, otherwise, right).

Once an item in the list is selected, a check mark is displayed next to it.
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■ Font color
Selecting this item displays a palette of colors.

Display Formats These items appear in the contextual menu when either a cell or a 
column is highlighted. From the menu, you can select one of the 4D 
default formats that match the data type of the column. Once selected, 
the format applies to the entire column, regardless of whether the 
current selection is a cell or a column. 

Summary Calculations These commands appear in the contextual menu when the current 
highlighted cell belongs to either the Grand total row or to a Subtotal 
row.

Selecting an item will insert the corresponding calculation in the 
highlighted cell (cf.  “Adding Summary Calculations” paragraph, 
page 173). Once an item in the list is selected for a cell, a check mark is 
placed next to it. It is possible to select several calculations 
successively. 

Column and Row 
Management Items

There are several items that are dedicated to column or row 
management:

■ Hide
Selecting this item hides the current column or row. Once it is hidden, 
a check mark is displayed next to the item, and the row or column is 
crossed out.
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■ Add...
This item is displayed when a row is highlighted or nothing is high-
lighted. Selecting this item displays the formula editor to allow you to 
define the data source for the new column. Once this is done, the new 
column is added to the right of the right-most existing column.

■ Insert...
This item is displayed only when a column is highlighted in list mode. 
Selecting this item displays the formula editor to allow you to define 
the data source for the new column. Once this is done, the new col-
umn is added to the left of the current highlighted column.

■ Delete
This item is displayed only when a column is highlighted in list mode. 
Selecting this item deletes the current highlighted column.

■ Edit...
This item is displayed only when a column is highlighted in list mode 
or when a cell is highlighted in cross-table mode. Selecting this item 
displays the formula editor to allow you to edit the data source for the 
current column (list mode) or for the current cell (cross-table mode).

■ Automatic Width
This item is displayed only when a column is highlighted in list mode, 
or when any cell is highlighted in cross-table mode. You can use this 
item to select or deselect the automatic width. When Automatic Width 
is selected, 4D will try to match the column size to the data so that the 
data fits on one line.
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Borders These items appear in the contextual menu when a cell, column or row 
is selected. Selecting Borders... displays the Borders dialog box:

For more information about this dialog box, refer to the  “Setting 
Borders” paragraph, page 163. 

Once defined, the border format is applied to the current selection 
(cell, row or column).

Selecting Rows, 
Columns, and Cells

When designing a List quick report, you need to select rows, columns, 
and cells in the quick report form. A cell is the intersection of a row 
and a column.

❿❿❿❿ To select a row:

■ Click on the Title, Detail, Subtotal, or Grand total cells in the row label 
area. 

❿❿❿❿ To select a column:

■ Click the Header row of a column. 

❿❿❿❿ To select a cell:

■ Click the cell.
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Adding and 
Modifying Text

You can add or modify text in the quick report form to label parts of the 
report. For example, if you requested summary calculations, you can 
label them by adding text to other cells in the Subtotal and Grand total 
rows.

You can add and modify text as follows:

■ Edit the text that 4th Dimension automatically adds to the Title row of 
the report,

■ Insert text in empty cells of the Subtotal and Totals rows,

■ Insert the value of a Subtotal field in the Subtotal rows,

■ Specify the font, font size, justification, and style for any text that 
appears in the report.

Adding Text

❿❿❿❿ To add text in a report cell:

1 Click twice on an empty cell in the quick report form.
A text insertion point appears in the cell.

If you are entering a label for a summary calculation, select a cell in the 
same row as the cell containing the calculation icons. You cannot enter 
text into the same cell that contains summary calculations.

2 Type the text in the cell. 

Modifying Text

❿❿❿❿ To modify text in a cell:

1 Double-click in a cell to get an insertion point and drag across the text 
in the cell you want to modify.
4th Dimension highlights the selected text.

2 Type the new text in the cell.



Chapter 8  Quick Reports

154 4th Dimension User Reference

Adding Columns In List mode, you create columns by dragging field names from the 
Fields list into the quick report area. If you want to add a field from a 
related table, expand the foreign key field in the hierarchical list of 
fields to display the fields in the related tables (if you have selected 
Related Tables or All Tables in the drop-down menu located just above 
the list). 
You can add fields from related tables, provided that the relationship is 
automatic. If you want to be able to use manual relations, check the All 
relations in automatic option: in this case, the editor changes all the 
relations of the database to automatic (cf.  “Interface” paragraph, 
page 142). 

Note You cannot add or edit a column in cross-table mode, since the report 
comes with all the needed columns.

❿❿❿❿ To add a field:

■ Drag the name of a field to the right of existing columns in the Quick 
Report area and release the mouse button.

OR
Double-click on the name of a field in the Fields list.

Note If you drag and drop a field onto an existing column, it will be replaced 
by the new column. 

4th Dimension creates a column for the field and places the field name 
in both the column header and the cell in the Header row. 

By default, 4th Dimension prints the field names as column heads at 
the top of each page in the quick report.

❿❿❿❿ To add a column using a menu command:

1 Select the Add... command in the Columns menu of the editor.
OR
Right-click (Windows) or Control+click (MacOS) over an unused area 
of the Quick Report area, then select the Add... command.

The standard 4th Dimension formula editor is displayed, allowing you 
to specify the data source of the new column (field or formula).
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Inserting Columns In List mode, you can insert an empty column into a quick report. 
After you insert the column, you can assign a field or a formula to it.

❿❿❿❿ To insert a column:

1 Select a column.

2 Choose Insert... from the Columns menu.

OR
Hold down the right mouse button (Windows) or Control+click 
(MacOS) to display the Quick Report contextual menu and choose 
Insert.

The standard 4th Dimension formula editor is displayed, allowing you 
to specify the data source of the new column (field or formula).
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Deleting Columns In List mode, as you specify fields for your quick report, you may want 
to remove some columns to place them elsewhere. Or, you might want 
to delete the column from the report.

❿❿❿❿ To delete a column using the Quick Report menu bar.

1 Select the column you want to delete. 

2 Choose Delete from the Columns menu.

OR

Right-click (Windows) or Control+click (MacOS) on the header of the 
column to be deleted, then select the Delete command from the 
contextual menu.

4th Dimension removes the selected column of the report. 

Replacing Columns In List mode, you can replace a column in the quick report by dragging 
another field over it. You can also replace a field with a formula and 
vice versa.

❿❿❿❿ To replace a column by a field:

1 Drag a field from the Fields list to the column you want to replace.
The replacement is instantaneous. If the previous field was designated 
as the sort level, the field that replaces it will also be substituted in the 
sort order list.
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❿❿❿❿ To replace a column using the formula editor:

1 Select the column you want to replace and choose Edit... from the 
Columns menu.
OR
Hold down the right mouse button (Windows) or Control+click 
(MacOS) on the header of the column to be replaced, then select the 
Edit... command in the contextual menu.
The standard Formula editor of 4th Dimension appears, allowing you 
to designate the new data source of the column (field or formula).

When you print the quick report, 4th Dimension will print the results 
of the formula for each record that appears in the Detail row. See the 
section “Associating Formulas to a Quick Report” on page 158 for 
information about adding a formula to a quick report.

Sizing Columns By default, the Quick Report editor sizes columns automatically, as 
reflected in the Automatic Width button. It sizes each column based on 
the maximum length of data displayed in the column and any labels 
typed into the column. The Quick Report editor sizes the columns at 
the time the report is printed. 
This operation is enabled for a column when the Automatic Width 
attribute has been associated with it. You can set and view the 
activation of this option in the Columns menu, in the contextual 
menu of the columns or using the corresponding button in the 
Columns toolbar:

To view the widths of each column, preview the report on the screen. 
See “Generating a Quick Report” on page 184 for more information 
about previewing the report. 

Because selecting the Automatic Width button or contextual menu 
item changes the width of a column based on the maximum width of 
data in the records being printed, selecting different records can 
change the size of the columns. 

You can resize a column manually, which automatically causes the 
deselection of the Automatic Width option (where applicable). 
When a column is set manually, text in the column wraps within the 
specified area.
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❿❿❿❿ To manually resize a column:

1 Select the column you want to resize.

2 Move the pointer over the column divider in the quick report to 
change the pointer into a column width cursor . 

3 Drag the column divider to the left or right to resize the column. 

Moving Columns In List mode, as you specify fields for your quick report, you may want 
to move some columns to place them elsewhere.

❿❿❿❿ To move a column using the Quick Report tool bar:

1 Select the column you want to move. 

2 Click the move icon to move it to the right or to the left: 

OR

3 Select Move right or Move left from the Columns menu to move the 
column as desired.
4th Dimension moves the selected column.

Associating 
Formulas to a Quick 
Report

You can add a formula to a column in a quick report. For example, you 
can add a formula that computes employees’ monthly salaries from an 
Annual Salary field.

❿❿❿❿ To associate a formula with a column:

1 Insert an empty column 
OR
Click an existing column and choose Edit... from the Columns menu.
OR
Double-click an existing column’s header. 
OR
Hold down the right mouse button (Windows) or Control+click 
(MacOS) on an existing column header to display the Quick Report 
contextual menu and choose Edit.
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4th Dimension displays the Formula editor, which you can use to build 
a formula. If you selected an existing column, the formula you create 
will replace the previous contents of the column.

Note Make sure that the formula you create does not change the current 
selection. Changing the current selection will cause problems when 
you print the quick report since the report is based on the current 
selection. For information about commands and functions that change 
the current selection, refer to the 4th Dimension Language Reference.

2 Build the formula by clicking on the fields, operators and commands, 
then enter the desired values in the editing area. 
OR
Click the Load... button to retrieve an existing formula from disk.
For more information about the formula editor, refer to the User Refer-
ence manual.

If you click the Load... button, 4th Dimension displays an open-file dia-
log box and asks you to select a file. When you load a file, it replaces 
any formula that currently appears in the Formula editor. After you 
load a formula, you can modify it in the editing area.

To save the formula as a file that you can retrieve and use in another 
column or in another report, click the Save... button and enter a file-
name in the dialog box.

3 Click OK to assign the formula to the column.
4th Dimension adds a new label to the column that identifies it as a 
formula. You can relabel the column by typing a label into the header 
cell for that column. The formulas are labelled C1 to Cn. These labels 
are the name of the variables containing the current value of the col-
umn. You can use these variables in other formulas.

Modifying the graphic attributes of a report
You can modify the graphic appearance of a quick report. The Quick 
Report editor lets you set the following attributes:

■ the character font, as well as its size, justification, style and color,

■ the background color of the cells,

■ the cell borders.
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In addition, 4th Dimension provides a set of predefined report 
templates that you can modify as desired. 

Note Appearance specifications are only taken into account for the “Printer” 
and “HTML File” output destinations (colors only). With other types of 
output, the formatting of reports must be carried out after the report is 
generated, using the receiving applications (4D View, 4D Chart or a 
text editor). For more information about report destinations, refer to 
the  “Generating a Quick Report” paragraph, page 184. 

Specifying 
Character Font, Size, 
Justification, Style 
and Color Attributes

While designing your quick report, you can specify different fonts, 
font sizes, justification, styles and colors. You can then apply these 
specifications to text, data, and summary calculations within rows, col-
umns, or cells in the quick report.

If you assign specifications to the Detail row of the report, you will not 
see the results until you preview or print the report.

You can specify font attributes using either the Quick Report menu 
commands or the Quick Report contextual menu.

❿❿❿❿ To specify a character font, font size, style, justification or color:

1 Hold down the right mouse button (Windows) or Control+click 
(MacOS) on the row label, column header, or cell to which you want 
to apply the font attributes.
A contextual menu appears.

2 Use the Font, Size, Style, Justification or Font Color submenus to 
change the font attributes as desired.
OR
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1 In the report, select the column, row or cell that you want to 
configure.

2 Choose a font in the drop-down font list and a size in the drop-down 
size list; then choose a style, justification and color in the Style toolbar:

Note You can also assign a style and justification using the Style menu. 

4th Dimension applies the parameters to the text, data or calculations 
included in the selected area.

Specifying the 
background color of 
cells

The Quick Report editor allows you to set a background color for each 
cell. You can set either a single color or two alternating colors, which 
provides better readability for tables. 

It is possible to set background colors for both List and Cross-table 
reports. 

Background colors are used with the “Print” and “HTML File” output 
destinations. 

❿❿❿❿ To set a background color:

1 Select a cell, column or row, then choose the main color in the 
“Background Color” palette of the toolbar:

You can assign any color combination that you want to the rows, cells 
and columns. 

Background 
Color palette
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2 (Optional) If you want to use an alternating background color, choose 
it using the “Alt. Background Color” palette:

The cells which have been assigned two alternating background colors 
will display both of them in the Quick Report editor. 

Here is an example of a generated report in List mode (preview) that 
has alternating background colors:

Alt. Background 
Color palette

Cell with an 
alternating back-
ground color
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Background colors are also taken into account in reports generated in 
HTML format:

Setting Borders You can set the borders for cells in both cross-table and list reports.

❿❿❿❿ To set the borders for a cell, a column or a row:

1 Highlight a cell, column or row, and either select Borders... in the 
contextual menu or from the Style menu.
The “Borders” dialog box is displayed:

Preview area

Shortcut buttons

Line thickness
selection area
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The preview area varies dynamically depending on the type of the 
selection: cell, column or row, but also whether a cell is in a list or 
cross table type report. For example, the behavior of the center cell in a 
cross-table report is different from the behavior of a detail cell in a list 
report. The center cell is repeated both horizontally and vertically for a 
cross-table report, whereas the detail cell in a list report is going to be 
repeated only vertically. Also, other cells may not be repeated at all 
(titles, for instance).

■ If the selected cell is a title cell (which is not repeated), the outer 
lines represent the outer lines of the cell:

■ If the selected cell is a detail cell in a List report (which is repeated 
vertically), the outer lines represent the outer lines of the cell repeti-
tion, and the inner horizontal line represents the border between 
two cells in the sequence:
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■ If the selected cell is the center cell in a Cross-table report (which is 
therefore repeated both horizontally and vertically), the outer lines 
represent the outer lines of the repetition of cells, and the inner 
lines represent the borders between each cell generated from the 
center cell:

2 Select the line thickness and color to use:

You can use different colors for different borders.

3 Select the borders using either the arrows or the shortcut buttons.
You will notice that some shortcut buttons are disabled to match the 
type of the cell you are editing.

4 Repeat steps 2 and 3 for each border to be configured. 

5 Click OK to validate the changes.
OR
Click Revert to revert to the original border settings.
OR
Click Cancel to discard the changes and close the dialog box.
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Using a predefined 
report template

The Quick Report editor contains a set of predefined templates 
providing various graphic approaches for the production of printed or 
HTML reports. You can use all of the template as is or you can use it as 
a basis for constructing your own reports. A template can be applied at 
any time. 

A report template combines a set of graphic characters: font, colors, 
style, borders and justification. You can use either all or part of the 
template characteristics.

❿❿❿❿ To use a predefined template:

1 Choose the Presentation... command in the Style menu. 

The template selection dialog box appears:

2 In the list of predefined templates, click on the one that you want to 
use. 

List of predefined 
templates

Preview area for the 
selected template

Graphic options to be 
used or excluded
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You can preview each template in the right-hand area of the dialog 
box. Choose the template that best corresponds to your needs, keeping 
in mind that you can always modify your report subsequently. 

3 If you do not want to use all the graphic options set by the template, 
you can uncheck each option that you do not want to be taken into 
account. 
By default, all the options are selected. If, for example, you uncheck 
the “Border” option, the borders defined by the template will not be 
applied to your report. 

Note Only the “Color” option will be taken into account for reports whose 
output destination is an HTML file. 

4 Click on Apply. 
The selected characteristics are immediately applied to your report. If 
any graphic attributes were set previously, they will be replaced. 

Keep in mind that certain characteristics will be only visible once the 
report has been generated. 

Sorting Records
An important feature of the Quick Report editor is the ability to sort 
the records in your report. You sort records for two reasons:

■ To view records in a particular order,

■ To create groups of records and subtotal areas in the report for the pur-
pose of reporting summary calculations for groups.

Specifying a Sort 
Order for a List 
Report

You can specify a sort order at any time; simply drag and drop a column 
into the Sort order list. 
For example, if you wanted to sort the records of salespeople by the 
Sales Region field, you would drag and drop the Sales Region column 
into the Sort order area.

You can also sort on a formula by selecting the column that contains 
the formula and placing it in the Sort order list. See the section 
“Associating Formulas to a Quick Report” on page 158 for more 
information about adding formulas to quick reports.

You can sort a report on several levels. The order in which the fields 
and formulas appear in the Sort order list indicates the sort level. 
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❿❿❿❿ To specify the sort order using the field list:

1 Drag the Field you want to set as the sort level from the Fields list to 
the Sort order list.
OR
Highlight the field from the Field lists and click on the field insertion 
button:

The field is then added to the Sort order list.

By default, sorts are carried out in increasing order (a -> z). You can 
reverse the direction of the sort by clicking on the triangle next to the 
field in the Sort order list. 

Note If the sorted field has not already been inserted into a report column, 
an additional column is automatically created in the Quick Report 
area. 

❿❿❿❿ To specify a sort for a column (field or formula):

1 Select Report Columns from the table selection drop-down list.
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The list then displays the headers of the columns present in the report:

2 Drag the column that you want to set as the sort level and drop it in 
the “Sort order” list.
OR
Highlight the field from the Field lists and click on the field insertion 
button:

4th Dimension then displays the name of the column in the Sort order 
list:
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Changing the sort level

❿❿❿❿ To change the level of a sort:

1 Right-click (Windows) or Control+click (MacOS) on the field in the 
Sort order list in order to display the contextual menu:

2 Select Up or Down to move the field up or down (respectively) in the 
sort levels.

Deleting a Field or 
Formula from the Sort 
List

You can delete any field or formula from the Sort list.

❿❿❿❿ To remove a field or formula from the Sort order:

1 Select the field or formula to be deleted in the sort list and display the 
contextual menu using a right-click (Windows) or Control+click 
(MacOS):

2 Select Delete.
The level is then removed.
Note that the associated column is not removed from the report. On 
the other hand, the associated subtotal row disappears.
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Sorting the Cross-
Table Values

In a Cross-table report, the only values that can be sorted are the 
horizontal and vertical data sources (the two data sources that are used 
as categories in the final table).

❿❿❿❿ To sort the categories in a cross-table report:

1 Click the sort indicators in the Sort order area.
An arrow indicates the sort order specified:

To modify or delete the sort order of a data source, click on it again. 
The different possible reports appear successively. 

When no arrow is displayed, no sort order is selected. In this case, 
values will be displayed in the order they appear in the selection. 

Subtotal Levels In a quick report, you set break levels to separate or “break” records 
into groups according to values in one or more sort fields. A break area 
is printed at each break level. You can print summary calculations in 
the break area. The summary calculations — sum, average, minimum, 
maximum, and count — are calculated for each group of records. 

Break levels are determined by the sort levels and Break rows. For 
example, if you sort records by Sales Region, 4th Dimension inserts a 
break between each group of records that have the same sales region. 
These rows are automatically inserted when a sort is defined:
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After you add a subtotal row to the quick report, you can request sum-
mary calculations on each break. For example, you can insert a sum-
mary calculation in a subtotal row to display subtotals for sales from 
each state in a marketing region. Refer to the section “Adding Sum-
mary Calculations” on page 173 for more information about adding 
summary calculations to Subtotal and Total rows.

The label of a subtotal row indicates which change in value triggers the 
break.

Using the Values of 
Break Fields in 
Labels

You can improve the appearance and comprehensibility of your 
reports by labeling each Subtotal row using the value of the Break field.

To request that the value of a Break field be printed in a label placed in 
the Break area, use the number sign (#) in the label. For example, the 
text “Total salaries for department #” will insert the department name 
(in this case, the value of the Department field) in place of the number 
sign when the report is printed.

The number sign does not need to be placed in the same column as the 
Break field. It will display the value of the Break field in any cell in the 
Subtotal row.

The following figure illustrates the use of the number sign in a label in 
the Subtotal row.

Subtotal rows

Number sign 
used in label
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Adding Summary Calculations
You can add summary calculations on the contents of fields and 
formulas to each Subtotal row and to the Totals row. In a cross-table 
report calculations can be inserted in the center row.

The calculation buttons in the toolbars of the Quick Report editor 
identify the summary calculation options available for quick reports.

The following summary calculations are available.

■ Sum  totals the values in the report or break.

■ Minimum  displays the lowest value in the report or break.

■ Maximum  displays the highest value in the report or break.

■ Average  calculates the average of the values in the report or break.

■ Count  calculates the number of records in the report or break.

These options also appear in the Quick Report contextual menu for 
cells in the Subtotal and Total rows or, for a Cross-table report, in the 
total cells and the center cell.

■ List Reports
When you place a summary calculation in the Totals row, the calcu-
lation is done for all records in the report. If you place the summary 
calculation in a subtotal row, separate calculations are done for the 
records in each break.
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■ Cross-table reports
Summary calculations will apply as follows

❿❿❿❿ To add a summary calculation:

1 Select a cell where you want to insert the summary calculation.
The Sum, Minimum, Maximum, and Average calculations work only 
on a numeric field or formula. 

2 Click as many summary calculation buttons as you like. 
OR
From the contextual menu, choose the desired summary calculations.
4th Dimension displays a calculation icon in the selected cell for each 
type of summary calculation you request. The following figure shows 
calculation icons in the Subtotal and Total rows.

If you add more than one summary calculation to a cell, 
4th Dimension stacks the calculation icons on top of each other, as 
shown above.

Applies to values 

Applies to values

in each column

in both the last column
and last row

Applies to values 
in each row

Applies to each 
cell of the table

Calculation icon
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Using Calculations 
and Column Values 
in Labels

You can insert summary calculations using the following codes. 

■ #S will be replaced by the sum in the sub-total or total row.

■ ##A will be replaced by the average.

■ ##C will be replaced by the count.

■ ##X will be replaced by the max.

■ ##N will be replaced by the min.

■ ##xx, where xx is a column number. This will be replaced by that 
column’s value, using its formatting. If this column does not exist, 
then it will not be replaced

These codes can be useful when you want to mix labels and data in a 
cell.

Displaying Repeated 
Values for Break 
Columns

In a report with subtotals, the columns which are used to group 
records so that summary calculations can be done are called Break 
columns. In the report shown above, the Department field is a Break 
column since the records in the report are grouped by department.

When a report like this is printed, the values for the Break column are 
printed only once per break. In other words, a department name is 
printed only for the first record in the group and is not repeated until 
the department changes.

In some cases, you may want to repeat the values for the Break col-
umns so that they appear for every record in the Break area. You do so 
by selecting the Repeated Values column property. This can be done 
either by clicking the Repeated Values button in the toolbars , by 
choosing the Repeated Values menu command in the Quick Reports 
contextual menu for that column, or by selecting Repeated Values 
from the Columns menu.

Non-repeating 
break values
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❿❿❿❿ To display repeated values for fields in a column:

1 Select the column by clicking the header row for that column and 
choosing the Repeated Values command in the Columns menu or 
clicking the Repeated Values button  in the “Columns” toolbar.
OR
From the contextual menu for that column, choose Repeated Values.

The following figure shows the report at the top of this page after the 
Repeated Values check box has been checked for the Department 
Name column.

Setting Display Formats
You can specify display formats for columns that contain numeric 
(integer, longint, real), alphanumeric (Alpha), date, time and picture 
data. 

For example, if you are displaying salaries in a column, you can add a 
numeric format to the Detail cell for the Salary field. The $###,##0.00;-
$###,##0.00 format places a dollar sign ($) to the left of the number 
and can display dollar amounts from -$999,999.99 to $999,999.99:

Break values 
(repeated)

Numeric format
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If your report includes Alpha fields such as a telephone number or 
Social Security number, you can use an Alpha format. If your report 
displays dates, times or pictures, you can also assign display formats to 
them.

4th Dimension provides different default display formats. However, 
you can create your own display styles for numeric and alphanumeric 
formats. For more information about this point, refer to the 
4th Dimension Design Reference manual.

Assigning the 
display format

You can associate a display format with a cell by selecting it in the 
contextual menu or by entering it directly in the cell. 

❿❿❿❿ To assign a display format to a numeric, Alpha, date, time or picture 
field:

1 Right-click (Windows) or Control+click (MacOS) on a cell of the 
column with which you want to associate a style.

The contextual menu of the editor appears.

2 Select the desired display format from the Format submenu:
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The contents of the submenu vary according to the type of data 
contained in the column: numeric, Alphanumeric, date, time or 
picture. If the report column contains data that cannot be formatted, 
the Format command does not appear in the contextual menu.

Note For more information about display formats, refer to the User 
Reference manual of 4th Dimension. 

The format is entered in the Detail cell. If you have also requested sum-
mary calculations for the column, the format specified in the Detail 
cell will automatically be applied to the summary calculations. The 
only exception is the “Count” calculation which is always displayed as 
an integer and does not accept any formatting symbols such as the dol-
lar sign.

You can also enter the formats to be applied manually by clicking 
twice in the cell and entering the elements of the format using the 
keyboard. 

Different formats can be applied to different columns in the report.

Hiding and Showing Rows and Columns
4th Dimension lets you hide rows or columns in a quick report in List 
mode. If desired, you can show a hidden column or row.

Hiding rows is useful when you want the report to include only sum-
mary calculations. For example, hide the Detail row if you want to dis-
play only the summary calculations that appear in the Totals and 
Subtotal rows. You can also use this feature to hide a Subtotal row or the 
Totals row.

You can hide a column if you need to use the column as a sort column, 
but do not want the report to display the column. 

You can hide/display a row or column using either a the Quick Report 
contextual menu, the Columns menu or the “Columns” toolbar.

Note You cannot hide a row or column in a cross-table report.



Hiding and Showing Rows and Columns

1794th Dimension User Reference

❿❿❿❿ To hide a row or column:

1 Select the row or column you want to hide by clicking on its header.

2 Right-click (Windows) or Control+click (MacOS) on the header of the 
row or column to be hidden, then choose Hide in the contextual 
menu:

OR
Choose the Hide command in the Columns menu of the Quick Report 
editor. 

OR
Click on the button  of the “Columns” toolbar. 
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4th Dimension displays the column in gray to remind you that the row 
will not appear when you print or preview the quick report.

Showing a Hidden 
Row or Column

When a row or column is hidden, a check mark (√) is displayed next to 
the Hide menu command in the Columns or contextual menu. In 
addition, the corresponding button of the “Columns” toolbar is 
pressed in.

You can display a hidden row or column by choosing Hide again from 
either the Columns or contextual menu or by pressing the 
corresponding button in the “Columns” toolbar again. When you do 
so, the row or column is displayed normally in the Quick Report area.

Adding Page Headers and Footers
Before printing a quick report, you can add page headers and footers. 
You specify page headers and footers in the Headers and Footers dialog 
box. Use this dialog box to do the following:

■ Add page header and footer text or picture,

■ Specify the size of the page header and footer areas,

■ Use separate text for left, center and right parts of the header and 
footer. 

■ Specify fonts, font sizes, and font styles for page header and footer text,

■ Insert codes that add page numbers and the date and time to your 
reports.

Hidden row

Hidden column
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You can only specify page headers and footers when printing to a 
printer. However, once they are defined, they are kept with the report, 
even if the destination is modified. See the section “Generating a 
Quick Report” on page 184 for more information about alternate 
output destinations.

❿❿❿❿ To add page headers and footers:

1 Choose Header and Footer... from the File menu.
The Headers and Footers dialog box appears.

Note The preview area takes the print format configuration into account. 

The Headers and Footers dialog box lets you specify both headers and 
footers using the same screen. Use the Headers/Footers drop-down list 
to indicate the one you currently want to define.

2 Choose Headers or Footers from the selection menu.

Picture 
insertion 
area

Headers/Footers
 drop-down list

Text insertion 
area

Page preview 
area
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3 Enter the header or footer height in the Height area. 
When you first enter the dialog box, the header and footer heights are 
set to 25 points each. You can not only change these values, but can 
change the measurement scale to enter values in inches or centimeters 
as well.

As you enter the header and footer height, the lines on the page 
preview area change to indicate the size of the header and footer as 
they will appear in the printed report.

4 If you want to use a picture, paste it in the picture area (using 
standard copy-paste commands):

5 Select its alignment by clicking on the alignment icons:

6 If you want the height of the picture to become the height of the 
header/footer, click the Apply button:
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7 Select an entry area and type the header or footer text.

To the right of each entry area, there are three buttons that let you 
enter variables into the entry area. 

You can insert the current page number, time of execution, or date of 
execution.

You can also use the code for the variables directly: #H for the time, #D 
for the date and #P for the page number.

8 Assign the font attributes for the header/footer.

9 Click OK to validate the changes.

Inserts the current time

Inserts the current date

Inserts the current page
number
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Generating a Quick Report
After you have completed your report design, you can “print” the 
quick report. You can print a quick report to a variety of output types:

■ On the standard printer selected,

■ To disk, in a Text file,

■ To a graph,

■ To a 4D View document,

■ To an HTML document.

❿❿❿❿ To select an output destination:

■ Choose Destination from the File menu. 

The Destination submenu contains five items.

Printer This option uses the printer you have chosen in your current print set-
tings. If you are printing to a printer, you can preview the report before 
printing it. 

❿❿❿❿ To print to a printer:

1 In the File menu, choose Printer from the Destination submenu.
This option is selected by default.

2 If necessary, select Page Setup from the File menu and specify your 
print parameters. 

Note This command is only available when the Printer destination is 
selected. 



Generating a Quick Report

1854th Dimension User Reference

3 If you want to preview your report, select Print Preview... in the File 
menu. 

Note This command is only available when the Printer destination is 
selected. 

The print preview dialog box appears, containing the report that you 
have defined with the current data of the database. 

4 Select Generate... in the File menu. 

5 Choose the settings that are appropriate for your report and click the 
OK button. 

Disk File This option sends your quick report to a disk file that you can open 
and modify with other applications, including text editors and spread-
sheets. This option exports the records in the quick report to a text file.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To generate the report in a Text file:

1 In the File menu, choose Disk File from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click OK.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to a file, 4th Dimension returns you to the 
Quick Report editor. Remember to change the output device if you 
want to resume sending a quick report to a standard printer.

Print to Graph This option directs the report to 4D Chart, 4th Dimension’s plug-in for 
plotting data. When you choose the Graph item in the Destination 
submenu, your report is presented as a graph rather than in table form. 
Your graph can then be printed using 4D Chart.
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■ In list mode, 4D Chart uses only the summary calculations and labels 
in the Subtotal row. It uses the leftmost non-numeric column for the 
Categories axis (the horizontal axis). To use the Graph feature, your 
report should:

■ Include from one to five numeric fields or formulas. These columns 
will be assigned to the values axis in the graph.

■ Use one type of summary calculation per numeric field.

For example, if you want to graph the average salary by department, 
you should create a quick report with two columns, Department Name 
and Salary as well as a Subtotal row consisting of the Average summary 
calculation for Salary:

■ In cross table mode, 4D Chart uses two data sources and the value cell. 
The last row and column are ignored.
For example, if you want to show the amount of sales per country for a 
set of products, you can define the following report:

❿❿❿❿ To print to a graph:

1 In the File menu, choose Graph from the Destination submenu.

2 Choose Generate... from the File menu. 

Value to be
represented graphically

Value to be represented 
graphically (Z axis)

Series (Y axis)

Elements (X axis)
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■ For list reports, 4th Dimension graphs your data as a 2D column 
graph.

■ For cross-table reports, 4th Dimension graphs the data as a 3D 
column graph:

You can use 4D Chart to select another graph type or print the graph. 
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Printing to a 4D 
View Document

This option directs the report to 4D View, 4th Dimension’s plug-in for 
displaying data. When you choose the 4D View item in the 
Destination submenu, your report is presented as a 4D View window 
rather than in table form. 4D View uses all the data in the report.

Note The 4D View destination is only available if this plug-in is installed in 
your 4th Dimension environment and if you have the appropriate 
licenses. 

❿❿❿❿ To generate a report in a 4D View document:

1 In the File menu, choose 4D View from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension creates a 4D View window containing the data. You can 
modify its contents, print it or save it using the 4D View menu com-
mands. 

Printing to an HTML 
Document

This option sends your quick report to an HTML file. When you 
choose this option, it uses the default HTML template unless it was 
changed programmatically.

When you use this option, 4th Dimension automatically uses the 
column headings as the first “record” that is exported.

❿❿❿❿ To print to an HTML file:

1 In the File menu, choose HTML File from the Destination submenu.

2 Choose Generate... from the File menu. 
4th Dimension displays a standard create-file dialog box and asks you 
to enter a filename. 

3 Enter a filename and click OK.
4th Dimension displays a dialog box that keeps you informed of the 
progress of the operation.

After the report is printed to an HTML file, 4th Dimension returns you 
to the Quick Report editor. Remember to change the output device if 
you want to resume sending a quick report to a standard printer.


